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Source:thesecmaster.comWe	will	show	you	how	to	Install	Windows	Server	2016	on	VMWare	Workstation.	You	can	use	this	method	to	run	Windows	Server	2016	on	your	personal	computer	and	practice	new	features	and	configurations	before	implementing	them	in	a	production	environment.	Windows	Server	2016	comes	with	a	lot	of	improvements	and
new	features.	And	like	always,	Microsoft	has	made	available	different	editions	of	Windows	Server	2016	for	different	users	and	scenarios.	In	this	article,	we	will	focus	on	the	Datacenter	edition,	which	is	the	most	feature-rich	edition	of	Windows	Server	2016.If	you	want	to	Install	Windows	Server	2016	on	VMWare	Workstation,	then	follow	this	guide.	We
will	show	you	step	by	step	process	to	Install	Windows	Server	2016	on	VMWare	Workstation.	For	your	note:	this	guide	is	also	applicable	for	installing	other	versions	of	Windows	Servers	and	Desktops	on	VMWare	Workstation.Table	of	Contents·	Basic	Requirments	To	Install	Windows	Server	2016	On	VMWare	Workstation?·	How	To	Install	Windows
Server	2016	On	VMWare	Workstation?Basic	Requirments	To	Install	Windows	Server	2016	On	VMWare	Workstation?Before	we	start	with	the	installation	process,	let’s	have	a	look	at	the	system	requirements	to	install	Windows	Server	2016	on	VMWare	Workstation.#1.	Host	Computer	to	run	VMWare	Workstation:The	Minimum	computational	resources
needed	to	run	Windows	Server	2016	on	VMWare	Workstation:Processor:	Intel	Core	2	Duo	processor	or	later.	AMD	Athlon™	64	X2	Dual	Core	Processor	3000+	or	higher	is	recommended.Memory:	4GB	of	RAM	or	more	is	recommended.	The	minimum	supported	is	2GB	of	RAM.	Note	that	memory	requirements	increase	as	guest	operating	systems	are
added.Storage:	60GB	of	available	storage	is	recommended.	Additional	storage	may	be	necessary	when	installing	guest	operating	systems.Network:	A	network	connection	is	required	for	installation	and	updates.#2.	Download	Windows	Server	2016	ISO	File:The	first	thing	you	need	is	the	ISO	file	of	Windows	Server	2016.	You	can	download	it	from	the
official	website	of	Microsoft.	Just	go	to	this	link	and	select	the	edition	you	want	to	download.	In	our	case,	we	will	be	downloaded	the	Datacenter	edition	because	it	is	the	most	feature-rich	edition.#3.	Install	VMWare	Workstation	15	Pro:After	downloading	the	ISO	file,	the	next	thing	you	need	is	virtualization	software.	In	this	article,	we	will	be	using
VMWare	Workstation.	You	can	also	use	other	virtualization	software	like	VirtualBox,	Hyper-V,	etc.Just	go	to	the	official	website	of	VMWare	and	download	the	latest	version	of	VMWare	Workstation	Pro.	Install	it	on	your	computer	and	launch	it.Now	that	we	know	the	system	requirements	let’s	start	with	the	installation	process.How	To	Install	Windows
Server	2016	On	VMWare	Workstation?Time	needed:	30	minutes.How	to	Install	Windows	Server	2016	on	VMWare	Workstation?1.	Open	the	new	Virtual	Machine	Wizard1.	Fire	up	VMWare	Workstation	2.	Go	to	File	->	New	Virtual	Machine	or	Ctrl	+	N2.	Select	Custom	Configuration	WizardSelect	Custom	Wizard	and	click	Next3.	Choose	VM	Hardware
Compatibility1.	Choose	the	compatible	hardware	from	the	drop-down	2.	Click	Next4.	Select	to	install	operating	system	later	option1.	Select	to	install	operating	system	later	option	2.	Click	Next5.	Select	the	guest	operating	system1.	Select	Windows	10	since	we	don’t	have	the	windows	server	option	included	yet.	2.	Click	Next6.	Virtual	Machine	Name	&
Location1.	Give	the	Virtual	Machine	Name	&	Location	2.	Click	Next7.	Select	Firmware	Type1.	You	can	select	either	BIOS	or	UEFI.	Note:	Only	new	boards	supports	UEFI.	2.	Click	Next8.	Allocate	the	number	of	processors	you	need1.	Allocate	how	many	processors	you	need.	This	depends	on	your	host	machine’s	hardware.	2.	Click	Next9.	Set	the
Memory	for	the	virtual	machine1.	This	depends	on	your	host	machine’s	hardware.	You	should	leave	the	memory	to	run	the	host	machine	without	hazels.	2.	Click	Next10.	Select	Network	Connection	settings	for	the	VM1.	Four	options	are	available	to	select.	Please	read	and	select	your	desired	network	setting.	2.	Click	Next11.	Choose	the	appropriate
storage	IO	controller1.	Choose	the	appropriate	storage	IO	controller	2.	Click	Next12.	Select	the	disk	type	for	the	VM1.	Select	the	available	disk	type	on	your	host	machine.	2.	Click	Next13.	Select	the	virtual	disk	for	the	VM1.	Select	the	virtual	disk	for	the	VM	if	not	create	a	new	disk	2.	Click	Next14.	Assign	the	disk	size	for	the	VMYou	can	select	a	single
or	split	virtual	disk	option.	Selecting	a	single	disk	will	increase	the	performance.	But,	if	you	want	to	move	the	disk	to	a	different	location	you	can	select	the	split	virtual	disk.Allocate	the	disk	size	and	click	next.15.	Give	the	path	where	you	want	to	keep	the	VM	disk1.	Give	the	location	where	you	want	to	save	the	disk.2.	Click	Next16.	Create	the	VM1.
VM	settings	are	ready	to	create	the	VM.	2.	Click	Finish17.	Load	the	ISO	image	to	boot	the	VM1.	Select	use	ISO	image	file2.	Browse	the	ISO	image3.	Click	Ok18.	All	set	to	power	on	the	VM19.	First	boot	screen	of	Windows	Server	201620.	Windows	Server	2016	installation	wizardThe	installation	wizard	will	appear	in	a	couple	of	seconds	after	the	boot	1.
Select	the	language	time	and	keyboard	settings	2.	Click	Next21.	Install	Windows	Server	2016Click	on	Install	Now22.	Select	The	Operating	System	You	Want	To	Install1.	Select	the	version	you	want	to	install	2.	Click	Next23.	Accept	the	License	Agreement24.	Select	installation	methodSelect	custom	installation	if	you	are	doing	a	fresh	installation.	Or,
select	upgrade	if	you	are	upgrading	your	older	Windows	Server	to	Windows	Server	2016.25.	Select	the	installation	disk	for	installationSelect	the	disk	and	click	on	Next	to	install	Windows	Server	2016.	If	you	want	to	create	additional	logical	partitions,	then	select	the	disk	and	click	on	new	assign	the	partition	size.	You	can	create	multiple	partitions
within	available	storage.26.	Installing	Windows	Server	201627.	Installation	is	in	progress…28.	Windows	getting	ready	after	the	installation	completes29.	Create	Administrator	User30.	Windows	Server	is	ready	to	use31.	Windows	Server	2016	Login	screen32.	First	look	at	Windows	Server	2016This	is	how	you	should	Install	Windows	Server	2016	on
VMWare	Workstation.Thanks	for	reading	the	post.	Please	share	this	post	with	those	who	want	to	know	the	procedure	to	Install	Windows	Server	2016	on	VMWare.	Please	let	us	know	if	you	want	to	know	more	about	this.	We	recommend	to	read	the	below	post	to	know	in	detail.	Please	share	this	post	if	you	find	this	interested.	Visit	our	social	media	page
on	Facebook,	LinkedIn,	Twitter,	Telegram,	Tumblr,	&	Medium	and	subscribe	to	receive	updates	like	this.This	post	is	originally	published	at	thesecmaster.comWe	thank	everybody	who	has	been	supporting	our	work	and	requests	you	check	out	thesecmaster.com	for	more	such	articles.	I've	downloaded	ISO	file	from	Microsoft	and	while	trying	Installer
disc	image	file	option	at	the	end	it	shows	an	error	"Windows	cannot	find	the	Microsoft	Software	License	Terms".	How	can	I	fix	this	error?	Thanks	5	Windows	Server	2016	documentation	covers	information	on	how	to	install	the	operating	system	in	a	virtual	machine.	For	additional	information	about	the	operating	system,	refer	to	the	instructions
included	in	the	installation	media.	Windows	Server	2016	documentation	includes	the	following	topics:	Installation	Instructions	You	can	install	Windows	Server	2016	in	a	virtual	machine	using	the	corresponding	Windows	Server	2016	distribution	CD.	Prerequisites	Before	you	begin,	verify	that	the	following	tasks	are	complete:	Read	General	Installation
Instructions	for	All	VMware	Products.	Read	the	Microsoft	System	Requirements	for	the	recommended	storage	and	memory	values.	Create	and	configure	a	new	virtual	machine	with	the	appropriate	virtual	storage	and	virtual	memory	to	support	the	intended	workload.	During	the	guest	OS	configuration	process,	select	Windows	Server	2016	Threshold
for	VMware	vSphere	6.0,	VMware	Workstation	11,	VMware	Fusion	7	and	later	releases.	For	VMware	vSphere	5.5,	if	the	Windows	Server	2016	Threshold	(64-bit)	option	is	not	available,	select	Windows	Server	2012	(64-bit).	Installation	Steps	Insert	the	Windows	Server	2016	CD/DVD	into	the	CD-ROM/DVD-ROM	drive.	Start	the	virtual	machine.	This
begins	the	Windows	installation.	(Optional)	If	you	are	using	VMware	Paravirtual	as	the	default	SCSI	controller,	refer	KB	84200	to	add	pvscsi	driver	to	the	Windows	installation	ISO	image,	or	install	the	pvscsi	driver	following	below	steps:	When	Windows	installer	displays	the	screen,	Where	do	you	want	to	install	Windows,	switch	the	current	virtual
machine's	CD	drive	to	point	to	the	VMware	Tools	.iso	image.	For	example,	in	the	vSphere	client:	Right	click	the	virtual	machine	and	select	Guest	OS	>	Install	VMware	Tools.	From	the	installer	screen,	Where	do	you	want	to	install	Windows,	click	Load	driver.	From	the	installer	screen,	Select	the	driver	to	install,	click	Browse	and	browse	to	the	CD
Driver/Program	Files/VMware/VMware	Tools/Drivers/pvscsi/amd64	driver	directory	in	the	VMware	Tools	.iso	image.	Click	OK,	wait	until	the	pvscsi	driver	is	recognized	successfully,	then	click	Next.	When	the	installer	displays	the	Where	do	you	want	to	install	Windows	screen,	switch	the	virtual	machine's	CD	drive	to	the	Windows	installation	disk	and
continue	the	Windows	installation.	For	example,	in	the	vSphere	client:	Right	click	the	virtual	machine	and	select	Guest	OS	>	Unmount	VMware	Tools	Installer	to	disconnect	the	CD/DVD	drive	from	vSphere	client.	Click	the	CD	icon	again	and	select	the	Windows	.iso	image.	Click	Next	to	continue	the	Windows	installation.	If	the	Next	button	is	gray	and
cannot	be	clicked,	click	Refresh,	then	re-click	Next.	Follow	the	prompts	to	complete	the	installation.	Install	VMware	Tools.	(Optional)	On	VMware	Fusion,	install	Boot	Camp	drivers	so	that	the	guest	operating	system	can	access	hardware	devices	on	the	physical	machine.	Boot	Camp	5.1	supports	64-bit	Windows.	For	more	information,	refer	to	.	VMware
Tools	in	a	Windows	Server	2016	Guest	For	information	on	VMware	Tools,	see	Knowledge	base	article	1014294,	General	VMware	Tools	installation	instructions,	at	.	Knowledge	Base	Articles	for	Windows	Server	2016	Guest	The	following	links	refer	to	knowledge	base	articles	on	operating	system	specific	issues.	VMware	Compatibility	Guide	The
VMware	Compatibility	Guide	Web	site	lists	supported	guest	and	host	operating	systems	and	provides	related	support	information.	Copyright	(c)	2006-2014	VMware,	Inc.	All	rights	reserved.	In	today’s	post,	I’ll	be	showing	you	how	to	install	Windows	Server	2016	on	VMware	ESXi	with	Desktop	Experience	on	an	ESXi	6.5	U1	host	managed	by	a	vCSA	6.5
U1	instance.	This	step-by-step	how-to	install	Windows	Server	2016	on	VMware	vSphere	guide	is	aimed	at	readers	who	have	yet	to	install	a	Windows	OS	on	a	VMware	hypervisor.	For	something	a	little	bit	more	advanced	in	relation	to	installing	Windows	Server	on	VMware,	you	can	take	your	pick	from	the	complete	list	of	published	posts	to	date.
Windows	Server	Flavors	and	Requirements	Windows	Server	2016	comes	in	3	flavors;	Server	Core	(no	GUI),	Server	with	Desktop	Experience	(with	GUI)	and	Nano	Server.	The	latter	is	Microsoft’s	headless	server,	one	that	is	completely	managed	remotely	with	no	local	logon	capabilities	making	it	a	perfect	solution	cloud	deployments.	Nano	server	has
recently	been	refactored	to	primarily	support	and	run	containers.	Windows	Server	2016	also	comes	in	3	editions;	Essentials,	Standard,	and	Datacenter.	Have	a	look	at	this	link	to	learn	how	each	edition	differs	from	the	rest.	As	far	as	hardware	requirements	go,	Microsoft’s	documentation	suggests	the	following.	Processor:	1.4	GHz	64-bit.	The	CPU
must	support	NX,	DEP,	CMPXCHG16b,	LAHF/SAHF,	PrefetchW	and	second-level	address	translation.	RAM:	512MB	or	2GB	for	a	Desktop	Experience	installation.	800	MB	is	the	required	minimum	when	installing	Windows	Server	2016	as	a	VM.	Storage:	32GB	absolute	minimum	As	often	is	the	case,	the	minimum	hardware	requirements	quoted	by
Microsoft	rarely	come	close	to	mirror	what’s	actually	needed	to	run	production	boxes.	With	that	in	mind,	consider	increasing	the	resources	allocated	in	accordance	with	the	role(s)	assigned	to	the	server	and	its	anticipated	workload.	Some	optional	requirements	are;	UEFI	firmware	to	support	secure	boot	where	applicable.	Trusted	Platform	Module
(TPM)	capabilities	to	enable	encryption	features	such	as	BitLocker.	Creating	the	base	VM	I’ll	be	using	the	new	vSphere	client	(HTML5)	to	create	the	base	VM.	Here	are	the	steps.	Step	1	–	Right-click	on	a	cluster,	or	host,	and	select	New	Virtual	Machine	(1).	Select	Create	a	new	virtual	machine	(2)	from	the	wizard.	Click	Next.	Step	2	–	Type	in	a	name
for	the	virtual	machine	(1)	and	select	a	location	(2),	such	as	a	datacenter,	where	you	want	it	installed.	The	Windows	folder	shown	is	something	I	created.	Step	3	–	Select	the	ESXi	host	where	the	VM	will	be	deployed	to.	In	the	example,	I	selected	a	DRS	enabled	cluster	(1)	so	placement	is	done	automatically.	Step	4	–	Select	a	datastore	(2)	where	the	VM
will	be	created.	If	you’re	using	storage	policies,	make	sure	to	select	the	correct	one	from	the	VM	Storage	Policy	drop-down	box	(1).	Step	5	–	Select	the	correct	compatibility	mode	according	to	the	ESXi	version	installed.	In	my	case,	I’ve	selected	ESXi	6.5	or	later.	Step	6	–	Select	Microsoft	Windows	Server	2016	(64bit)	guest	OS	Family	and	Version
types.	If	you’re	running	this	on	older	versions	of	ESXi,	select	Microsoft	Windows	Server	2012	(64	bit)	instead.	Step	7	–	For	the	hardware	requirements,	I’m	sticking	with	the	values	suggested	to	me	by	the	wizard.	The	only	hardware	settings	I	changed	are	the	ones	for	the	SCSI	controller,	which	I	set	to	VMWare	Paravirtual,	and	the	vNIC	driver	which	I
set	to	vmxnet3.	This	should	improve	the	overall	performance	of	the	virtual	machine.	I	also	set	the	VMDK	type	to	thin	since	I’m	a	bit	short	on	storage	space.	To	use	the	Secure	Boot	feature,	change	the	BIOS	firmware	setting	to	EFI	by	navigating	to	Boot	Options	->	Firmware	under	the	VM	Options	tab.	Step	8	–	Review	the	configuration	and	press	Finish
to	create	the	VM.	Installing	Windows	Server	2016	Now	that	the	VM	has	been	created,	it’s	time	to	install	the	guest	OS.	For	this	task,	I’ll	be	using	the	Remote	Console	client	as	I	find	it	easier	to	use	when	mounting	ISOs	on	VMs	and	such.	Step	1	–	Highlight	the	VM	just	created	and	click	on	Launch	Remote	Console	link.	Step	2	–	Power	up	the	VM	and
select	Connect	to	Disk	Image	File	(iso)	from	the	VMRC	->	Removable	Devices	->	CD/DVD	drive	1.	Navigate	to	the	folder	containing	the	Windows	Server	2016	ISO	image	and	select	it.	Step	3	–	Select	Send	Ctrl+Alt+Del	from	the	VMRC	drop-down	menu.	You	should	see	the	Windows	installer	booting	up.	Step	4	–	Select	the	language	and	localization
settings	matching	your	time	zone	and	country	and	click	Next.	Step	5	–	Click	on	Install	now	to	kick	off	the	installation.	Step	6	–	Type	in	the	product	key,	if	you	have	one,	and	press	Next.	If	you	don’t,	just	click	on	the	I	don’t	have	a	product	key	link	to	install	Windows	Server	in	evaluation	mode.	Step	7	–	Select	the	Windows	Server	edition	and	deployment
type.	For	this	example,	I’ve	selected	Windows	Server	2016	Standard	(Desktop	Experience).	Press	Next.	Step	8	–	Accept	the	license	terms	by	ticking	on	the	option	at	the	bottom	and	press	Next.	Step	9	–	Select	Custom:	Install	Windows	only	(advanced)	Step	10a	–	At	this	point	on	how	to	install	Windows	Server	2016	on	VMware	vSphere,	I	must	mount	the
vmtools	ISO	image	since	I	selected	VMware	Paravirtual	as	the	SCSI	controller.	This	step	is	not	required	if	you	stick	by	the	default	setting	(LSI	Logic	SAS).	To	this,	we	simply	select	Install	VMware	Tools	from	VMRC	->	Manage.	This	will	mount	the	corresponding	ISO	image	on	the	VM.	Once	you	do,	click	on	Load	driver,	select	the	CD	drive	labelled
VMware	Tools	and	drill	down	to	the	/Program	Files/VMware/VMware	Tools/Drivers/pvscsi/Win8/amd64	folder	as	shown	next.	Step	10b	–	The	VMware	PVSCSI	Controller	driver	is	automatically	selected	for	you.	Click	Next	to	continue.	Step	11	–	If	you	see	Drive	0	Unallocated	Space	listed,	it	means	that	the	paravirtual	driver	has	correctly	detected	the
VMDK	specified	for	the	VM.	Before	pressing	Next,	disconnect	the	VMware	Tools	ISO	image	and	reconnect	the	one	for	Windows	Server	2016.	You	won’t	be	able	to	proceed	with	the	process	of	installing	Windows	Server	on	VMware	unless	you	do	this.	Once	you	reconnect	the	Windows	Server	ISO,	press	Refresh	and	make	sure	that	the	Windows	can’t	be
installed	…	at	the	bottom	clears.	Press	Next	to	use	the	entire	disk	for	the	Windows	Server	installation.	Step	12	–	Wait	for	the	installation	of	Windows	to	finish.	Step	13	–	Set	a	password	for	the	administrator	account	and	press	Finish.	Step	14	–	Log	in	and	install	the	VMware	Tools.	Disconnect	the	Windows	Server	ISO	image	as	described	and	mount	the
VMware	Tools	ISO	image	still	using	the	VMware	Remote	Console	client	(VMRC	->	Manage	->	Install	VMware	Tools).	Click	on	the	mounted	DVD	Drive	or	taskbar	notification	to	run	the	vmtools	installer.	Follow	the	instructions	and	reboot	the	VM	when	done.	Congratulations!	You	now	have	Windows	Server	2016	with	Desktop	Experience	running	on
VMware.	For	production	environments,	you	should	go	for	the	Server	Core	version	for	better	performance	and	improved	security.	Also,	note	that	the	steps	covered	today	apply	to	installing	Windows	Server	2016	on	both	physical	ESXi	hosts	as	well	as	nested	ones.	If	you	wish	to	learn	how	to	set	up	a	nested	vSphere	environment,	have	a	look	at	this	post.
What	to	do	next?	Although	these	were	easy	steps,	they	were	rather	time-consuming,	especially	if	you	deploy	several	VMs	a	week.	This	is	why	installing	Windows	Server	in	a	VM	is	usually	done	with	the	aim	to	convert	it	to	a	template	afterwards.	That	way	you	can	simply	deploy	a	new	VM	from	the	template	and	ensure	consistency	in	terms	of	custom
configuration	and	installed	applications.	Once	you’ve	installed	Windows	Server	and	the	VMware	Tools,	it	is	usually	a	good	measure	to	set	whatever	settings	you	want	across	the	board	when	deploying	a	new	VM.	A	lot	of	these	can	be	done	via	GPO	or	deployment	tools	but	you	may	get	the	odd	change	you	want	to	be	done	locally.	For	instance:	Add	a
specific	local	user	Add	specific	user	in	the	remote	desktop	group	Install	agents	for	monitoring,	backup,	antivirus…	Install	tools	such	as	BGInfo	Run	Windows	Update	and	clean	up	files	You	can	find	interesting	resources	on	how	to	prep	a	Windows	environment	with	the	VMware	OS	Optimization	Tool	that	is	used	for	Horizon	Desktops.	Conclusion	Note
that	the	steps	on	how	to	install	Windows	Server	2016	on	VMware	ESXi	covered	today	also	apply	to	installing	Windows	Server	2016	on	both	physical	ESXi	hosts	as	well	as	nested	ones.	Installing	Microsoft	Windows	Server	2016	on	a	virtual	machine	hosted	on	VMware	ESXi	is	straightforward	if	you	follow	our	steps	and	perform	the	operations	explained
above	with	illustrations.	The	illustrated	practices	show	how	you	can	build	a	virtual	machine	for	Windows	hosted	by	VMware	ESXi.	It	is	a	fantastic	opportunity	for	anyone	willing	to	get	started	with	virtualization.	If	you	wish	to	learn	how	to	set	up	a	nested	vSphere	environment,	have	a	look	at	this	post.	Virtual	machines	are	arguably	the	heart	of	the	IT
industry	today.	Using	hypervisors	IT	staff	can	run	multiple	operating	systems	on	a	single	computer	through	application	windows.	Do	you	know	how	to	create	a	virtual	machine	with	specific	operating	systems?	In	this	article	I	will	demonstrate	how	to	install	Windows	Server	2016	on	VMware	Workstation,	VMware	ESXi	or	Hyper-V	virtual	machine	as	an
example.	Before	you	start	install	Windows	Server	2016	on	virtual	machine,	please	prepare	a	hypervisor	and	Windows	Server	2016	iso	file.	You	can	download	from	official	site,	or	create	a	disk	image	from	existing	windows	server	2016.	If	you	want	to	install	other	versions	like	Windows	Server	2019	on	virtual	machine,	the	steps	are	basically	the	same.
Windows	Server	2016	editions	Datacenter:	Highly	virtualized,	enterprise	network	and	cloud	environment.	Standard:	Datacenter	edition	supports	less	virtual	servers	than	Datacenter	edition.	Essential:	Up	to	25	users	and	50	devices,	suitable	for	small	businesses.	How	to	install	Windows	Server	2016	on	VMware	Workstation	1.	Launch	VMware
Workstation,	click	Create	a	New	Virtual	Machine	to	open	the	wizard.	2.	Select	the	type	of	configuration	as	Typical	(recommended)	or	Custom	(advanced).	Click	Next.	By	selecting	Custom,	you	will	create	a	virtual	machine	with	advanced	options,	such	as	a	SCSI	controller	type,	virtual	disk	type	and	compatibility	with	older	VMware	products.	Here	I
select	Typical	as	demonstration.	3.	Select	to	install	from	Installer	disc	image	file	(iso)	and	click	Browse…	to	select	the	iso	file	you	prepared.	Click	Next.	You	can	also	select	I	will	install	the	operating	system	later	option	to	create	a	VM	with	blank	hard	disk.	4.	Provide	the	following	easy	install	information	for	Windows	Server	2016	installation.	(Optional)
Windows	product	key	Version	of	Windows	to	install	Full	name	(Optional)	Password	(Optional)	Log	on	automatically	(requires	a	password)	Click	Next.	5.	Provide	a	name	for	the	new	virtual	machine,	and	click	Browse…	to	specify	a	location	to	store	the	VM	files.	Click	Next.	6.	Specify	Disk	Capacity,	and	select	to	Store	virtual	disk	as	a	single	file,	or	Split
virtual	disk	into	multiple	files.	Click	Next.	Tip:	1.	The	recommended	size	for	Windows	Server	2016	is	40	GB.	2.	It	is	recommended	by	VMware	to	split	virtual	disk	into	multiple	2GB	files:	Advantages	of	split	disks:	a.	Free	diskspace	required	to	merge	a	snapshot,	shrink,	or	defragment	the	disk	is	limited	to	2	GB,	while	monolithic	disks	require	up	to	950
GB.	b.	Easy	to	copy,	move	or	backup.	Some	file	systems	do	not	support	such	large	files	like	monolithic	disks.	c.	Create	external	descriptor	files	that	can	be	manually	edited	by	a	simple	text	editor,	allowing	users	to	easily	fix	simple	errors.	Disadvantages	of	split	disks:	a.	Not	favorable	for	management.	b.	Not	easy	for	encryption.	You	can	also	merge
VMDK	files	into	one	later	if	necessary.	7.	Review	the	settings,	and	click	Finish	to	create	the	virtual	machine.	8.	Power	on	the	new	virtual	machine,	and	then	VMware	Easy	Install	will	install	Windows	Server	2016	and	VMware	Tools	automatically.	Now	you’ve	successfully	installed	Windows	Server	2016	on	a	VMware	Workstation	virtual	machine.	You
can	then	configure	this	local	server	by	following	the	Server	Manager	steps.	Power	off	the	virtual	machine	and	click	Edit	virtual	machine	settings	you	can	change	the	basic	settings.	How	to	install	Windows	Server	2016	on	VMware	ESXi	1.	Access	to	VMware	ESXi	web	client,	navigate	to	Virtual	Machines	>	Create	/	Register	VM	to	open	the	wizard.	2.
Select	creation	type	as	Create	a	new	virtual	machine.	Click	Next.	3.	Provide	a	Name	and	identify	the	guest	operation	system	Compatibility	information.	Click	Next.	4.	Select	a	datastore	to	store	the	VM	files.	Click	Next.	Tip:	You	can	also	migrate	or	backup	VM	to	another	datastore	on	VMware	ESXi.	5.	Configure	the	virtual	machine	hardware	and	virtual
machine	additional	options.	Click	Next.	6.	Review	the	settings	and	click	Finish	to	create	the	virtual	machine.	7.	Power	on	the	newly	created	virtual	machine	and	Launch	remote	console.	8.	Click	VM	>	Settings	on	the	toolbar	to	open	the	settings	window.	9.	Navigate	to	CD/DVD	drive	1	from	the	left	inventory,	select	Location	as	Local	Client,	and	select
Use	ISO	image	file	option,	click	Browse…	to	specify	the	iso	file.	Then	click	OK	and	press	Enter	to	continue.	10.	Now	you	can	install	Windows	Server	2016	normally.	Click	Next	to	continue.	11.	Provide	a	product	key	to	activate	windows.	If	you	don’t	have	one,	click	I	don’t	have	a	product	key.	12.	Select	a	Windows	Server	2016	edition	you	want	to	install.
13.	Select	installation	type	as	Custom:	Install	Windows	only	(advanced).	14.	Specify	a	drive	to	install	Windows	Server	2016.	Click	Next.	15.	Now	Windows	Server	2016	is	installing	on	this	virtual	machine.	Wait	for	the	process	completed	and	then	provide	administrator	information,	you	are	free	to	use	Windows	Server	2016	on	VMware	ESXi	virtual
machine.	How	to	install	Windows	Server	2016	on	Hyper-V	virtual	machine	1.	Launch	Hyper-V	Manager,	click	Action	>	New	>Virtual	Machine…	to	open	the	wizard.	Click	Next	to	continue.	2.	Specify	a	Name	for	the	virtual	machine.	And	by	checking	Store	the	virtual	machine	in	a	different	location	option	you	can	change	the	default	storage.	Click	Next.
3.	Specify	the	generation	of	the	new	virtual	machine	as	Generation	2.	Click	Next.	Tip:	It	is	recommended	to	create	a	Generation	2	VM	to	install	Windows	Server	2016	for	the	following	reasons:	a.	Higher	security	with	UEFI	Secure	Boot	and	Trusted	Platform	Module	b.	Larger	boot	volume	that	up	to	64	TB	(up	to	2	TB	on	Generation	1	VM)	c.	Higher
performance	provided	by	higher	CPU	and	maximum	memory	d.	More	boot	options	such	as	PXE	boot	with	synthetic	network	adapter,	and	boot	from	SCSI	disk	Actually,	if	you	are	installing	a	64-bit	operation	system,	it	is	better	to	select	Generation	2.			However,	under	the	following	cases	you	need	to	select	Generation	1.	a.	Running	32-bit	operating
systems	(not	supported	by	Generation	2)	b.	Need	to	use	COM	ports	and	virtual	floppy	disks	c.	Need	to	migrate	or	backup	virtual	machines	to	Azure,	Windows	Server	2008	or	2012	host.	4.	Assign	memory	for	the	virtual	machine.	By	checking	Use	Dynamic	Memory	for	this	virtual	machine	option,	Hyper-V	will	automatically	reassign	RAM	of	virtual
machines	as	demand	changes.	Click	Next.	5.	Configure	networking	for	this	virtual	machine.	Click	Next.	6.	Select	Create	a	virtual	hard	disk	option	and	specify	a	Name,	Location,	and	Size	for	the	disk.	Click	Next.	Note:	By	default,	Hyper-V	creates	thin-provisioned	disks	that	of	lower	performance	than	thick	disks.	If	you	want	to	create	a	thick	disk	you	can
select	Attach	a	virtual	hard	disk	later	option.	7.	Select	Install	an	operation	system	from	a	bootable	image	file	option	and	click	Browse…	to	specify	the	iso	file	you	prepared.	Click	Next.	8.	Review	the	settings	and	click	Finish	to	create	the	virtual	machine.	Now	the	virtual	machine	is	successfully	created.	Right-click	on	the	VM	name	and	select	Start	you
can	install	Windows	Server	2016	on	this	Hyper-V	virtual	machine.	Later	on,	if	you	want	to	switch	your	VM	environment	between	Hyper-V	and	VMware,	but	find	it	laborious	to	recreate	a	new	VM	from	scratch,	you	can	also	convert	Hyper-V	to	VMware,	or	vice	versa.	Backing	up	your	virtual	machines	to	ensure	data	security	(Free)	After	successfully
install	Windows	Server	2016	on	virtual	machine,	the	next	thing	you	need	to	do	is	backing	up	your	virtual	machines	to	ensure	data	security.	Except	for	backing	up	once,	scheduling	a	regular	backup	strategy	can	ensure	that	backups	are	updated	timely	and	retain	as	many	restore	points	as	possible.	Here	I	introduce	you	2	professional	and	free	virtual
machine	backup	software	-	AOMEI	Cyber	Backup	&	AOMEI	Backupper.	Way	1.	Use	AOMEI	Cyber	Backup	to	create	a	centralized	VM	backup	AOMEI's	agentless	VM	backup	has	been	transformative	for	the	struggling	traditional	backup	tools.	It	seamlessly	and	reliably	secures	your	vital	data,	all	managed	effortlessly	through	a	centralized	console.	Even
in	the	face	of	potential	IT	system	hiccups	during	working,	your	critical	data	remains	unscathed.	It	can	not	only	provide	secure	VM	backup,	but	also	the	Microsoft	SQL	database	backup	and	Windows	Server	backup.	✦	Easy-to-use	VMs	Backup:	with	3	easy	steps	you	can	create	a	complete	backup	task	of	VMs	on	the	host.	✦	Flexible	Schedule:	create
backup	task	with	a	flexible	schedule	to	autorun	it	daily,	weekly,	monthly.	✦	Restore	Entire	VM:	restore	the	entire	VM	from	any	history	backup	versions	easily	and	securely.	✦	Supported	Versions:	VMware	ESXi	6.0	and	all	later	versions,	Windows	Server	2012	and	all	later	versions.	✦	Role	Assignment:	allows	one	administrator	to	create	sub-accounts
with	limited	privileges,	effectively	avoid	errors	caused	by	others’	mis-operations.	Next	I	will	demonstrate	how	to	quickly	backup	VMs	using	AOMEI	Cyber	Backup.	You	can	click	the	following	button	to	download	the	perpetual	free	edition:	1.	Bind	devices:	Access	to	AOMEI	Cyber	Backup	web	client,	navigate	to	Source	Device	>	Hyper-V	>	+	Add	Hyper-
V	to	add	a	host.	And	then	click	…	>	Bind	Device.	2.	Create	backup	tasks:	Navigate	to	Backup	Task	>	+	Create	New	Task,	and	set	Task	Name,	Backup	Type,	Device,	Target,	Schedule.	Device:	select	the	VMs	on	the	host	to	backup.	Target:	selecting	to	back	up	to	a	local	path,	or	to	a	network	path.	Used	paths	will	be	saved	in	Favorite	Storage	for	handy
selection.	Schedule:	choosing	to	perform	full	or	incremental	backup,	and	automate	execution	daily,	weekly	or	monthly	according	to	the	frequency	you	specified.	Cleanup*:	specifying	a	retention	period,	and	the	old	backup	files	that	exceed	the	period	will	be	automatically	deleted.	This	is	an	advance	feature	which	you	can	upgrade	to	enjoy.	3.	Start
Backup:	You	can	select	Add	the	schedule	and	start	backup	now,	or	Add	the	schedule	only.	Way	2.	Use	AOMEI	Backupper	for	free	VM	backup	AOMEI	Backupper	Standard	can	be	installed	on	a	virtual	machine	to	back	up	the	operating	system,	configuration	files,	installed	programs,	personal	data,	etc.	With	it,	you	can	backup	disk	to	physical	computer
or	other	computers	via	network.	Also,	you	can	backup	virtual	machine	to	external	hard	drive,	such	as,	USB	flash	drive,	HDD,	or	SSD.	You	can	use	AOMEI	Backupperto	backup	your	VMs	as	physical	machine	or	backup	the	VMDK	files.	For	example,	we	are	going	to	create	a	File	Backup	of	your	virtual	machine.	1.	Launch	AOMEI	Backupper	Standard.
Then,	click	Backup	and	File	Backup	in	turn.	Step	2.	Click	Add	Folder	to	select	the	folder	contains	all	items	of	your	virtual	machine.	Step	3.	Select	a	destination	path	for	your	VM	files.	It	can	be	any	detected	storage	in	Windows.	Step	4.	Set	schedule	backup	and	click	Start	Backup.	Summary	Using	virtual	machines,	you	can	run	multiple	different
operating	systems	in	application	windows.	In	this	article	I	introduced	how	to	install	Windows	Server	2016	on	virtual	machine	step	by	step.	The	same	steps	also	apply	to	other	versions	such	as	Windows	Server	2019	installation,	or	Windows	Server	2022	installation.	After	the	installation,	now	you	can	work	with	Windows	Server	2016	freely.	But	please
remember	to	perform	virtual	machine	backups	regularly	if	you	don’t	want	to	lose	your	data.	Share	—	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you
follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your
contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable
exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	Here	we	are	with	a	new	series	of	articles	covering	Windows	Server	2016.	In	particular	in	this	series	of	articles
we’ll	start	covering	from	the	basic	steps	to	configuration	setup	we	can	use	to	learn	more	about	Enterprise	features.	In	particular,	I’m	excited	to	start	using	the	new	ReFS	file	system	shipping	with	Windows	Server	2016.		It	would	be	interesting	to	use	ReFS	volumes	as	Repositories	for	our	Backup	taking	advantage	of	the	built-in	de-duplication
capabilities.	But	there’s	a	lot	more.	Other	interesting	features	of	course	include	the	updated	components	like	the	new	version	of	Hyper-V	and	how	to	leverage	this	in	a	nested	hypervisor	environment.	Last	but	not	least	also	the	Nano	Server	variation	which	of	course	makes	this	the	preferred	choice	for	low	resource	consumption	environments.	Not	to
miss	on	the	fact	that	this	kind	of	server	deployments	also	help	with	the	hardening	aspects,	from	a	security	perspective	thus	reducing	the	surface	attacks.	There	are	plenty	of	reason	really	to	start	trying	and	learning	about	the	latest	Windows	Server	edition	in	our	home	lab	environment.	Let’s	take	it	step	by	step.	We’ll	begin	with	steps	to:	Deploy
Windows	Server	2016	Guest	OS	on	VMware	vSphere	Install	Windows	Server	2016	Configure	VMware	Tools	I	will	keep	this	list	open	for	future	updates	and	this	article	as	a	sort	of	placeholder	for	additional	steps.	Let’s	begin	by	creating	the	Guest	OS	for	Windows	Server	2016.	Deploy	Windows	Server	2016	on	VMware	vSphere	6	From	the	vCenter	let’s
do	a	right-click	to	the	Data	Center	or	Host	object	to	start	creating	a	new	Virtual	Machine.	This	will	start	the	wizard	as	per	screenshot	below.	Let’s	provide	a	name	to	the	Guest	OS.	By	default	the	same	name	is	used	to	create	the	vm	folder	which	will	include	all	the	necessary	files.	Let’s	also	choose	the	location	in	the	infrastructure	where	to	deploy	this
virtual	machine.	Next	is	to	choose	the	Host	which	will	run	this	virtual	machine.	Let’s	make	sure	the	compatibility	section	below	is	good	to	go.	At	this	point	we	can	select	the	physical	location	namely	the	Datastore	where	the	Guest	OS	will	be	created.	Depending	on	the	home	lab	environment	we	might	want	to	use	an	older	version	of	the	Guest	OS	virtual
hardware.	Should	this	be	the	case	it	is	always	possible	to	upgrade	the	Virtual	Hardware	to	the	latest	version	according	to	the	current	vSphere	Host	release.	At	this	point	we	can	select	the	Guest	OS	Family	and	OS	version	as	per	screenshot	below.	This	will	help	VMware	vSphere	to	use	the	correct	Virtual	Machine	template	to	install	the	VMware	Tools
as	we’ll	see	later	on.	In	this	step	we	can	further	customize	the	Virtual	Hardware	presented	to	the	Guest	OS.	In	my	case	I	will	go	for	simple	specs	as	ideally	I	would	like	to	clone	this	virtual	machine	avoiding	the	same	steps	again.	Eventually	add	or	tweak	the	Virtual	Hardware	resources	as	required.	Also	let’s	make	sure	the	VM	Network	is		associated	to
the	correct	Port	Group.	So	essentially	in	this	step	we	can	also	map	the	Windows	Server	ISO	to	boot	from	and	begin	the	installation	process.	Unless	required	the	default	settings	are	fine.	Of	course	let’s	change	them	where	required	to	fit	our	needs.	And	finally	a	quick	summary	of	the	main	settings	to	review	before	amending	changes.	Naturally	all	of
these	settings	can	be	changed	later	on.	Some	of	them	also	when	the	virtual	machine	is	running.	This	concludes	the	first	article	on	how	to	install	Windows	Server	2016	on	VMware	vSphere.	Pretty	easy!	Same	applies	to	the	next	steps	with	the	actual	installation	of	the	Windows	Server	OS	as	per	next	article.	We	will	show	you	how	to	Install	Windows
Server	2016	on	VMWare	Workstation.	You	can	use	this	method	to	run	Windows	Server	2016	on	your	personal	computer	and	practice	new	features	and	configurations	before	implementing	them	in	a	production	environment.	Windows	Server	2016	comes	with	a	lot	of	improvements	and	new	features.	And	like	always,	Microsoft	has	made	available
different	editions	of	Windows	Server	2016	for	different	users	and	scenarios.	In	this	article,	we	will	focus	on	the	Datacenter	edition,	which	is	the	most	feature-rich	edition	of	Windows	Server	2016.If	you	want	to	Install	Windows	Server	2016	on	VMWare	Workstation,	then	follow	this	guide.	We	will	show	you	a	step-by-step	process	to	Install	Windows
Server	2016	on	the	VMWare	Workstation.	For	your	note:	this	guide	is	also	applicable	for	installing	other	versions	of	Windows	Servers	and	Desktops	on	VMWare	Workstation.Basic	Requirments	To	Install	Windows	Server	2016	On	VMWare	Workstation?Before	we	start	with	the	installation	process,	let’s	have	a	look	at	the	system	requirements	to	install
Windows	Server	2016	on	VMWare	Workstation.#1.	Host	Computer	to	run	VMWare	Workstation:The	Minimum	computational	resources	needed	to	run	Windows	Server	2016	on	VMWare	Workstation:Processor:	Intel	Core	2	Duo	processor	or	later.	AMD	Athlon™	64	X2	Dual	Core	Processor	3000+	or	higher	is	recommended.Memory:	4GB	of	RAM	or
more	is	recommended.	The	minimum	support	is	2GB	of	RAM.	Note	that	memory	requirements	increase	as	guest	operating	systems	are	added.Storage:	60GB	of	available	storage	is	recommended.	Additional	storage	may	be	necessary	when	installing	guest	operating	systems.Network:	A	network	connection	is	required	for	installation	and	updates.#2.
Download	Windows	Server	2016	ISO	File:The	first	thing	you	need	is	the	ISO	file	of	Windows	Server	2016.	You	can	download	it	from	the	official	website	of	Microsoft.	Just	go	to	this	link	and	select	the	edition	you	want	to	download.	In	our	case,	we	will	be	downloaded	the	Datacenter	edition	because	it	is	the	most	feature-rich	edition.#3.	Install	VMWare
Workstation	15	Pro:After	downloading	the	ISO	file,	the	next	thing	you	need	is	virtualization	software.	In	this	article,	we	will	be	using	VMWare	Workstation.	You	can	also	use	other	virtualization	software	like	VirtualBox,	Hyper-V,	etc.Just	go	to	the	official	website	of	VMWare	and	download	the	latest	version	of	VMWare	Workstation	Pro.	Install	it	on	your
computer	and	launch	it.Now	that	we	know	the	system	requirements	let’s	start	with	the	installation	process.How	To	Install	Windows	Server	2016	On	VMWare	Workstation?Step	1.	Open	the	new	Virtual	Machine	Wizard1.	Fire	up	VMWare	Workstation2.	Go	to	File	->	New	Virtual	Machine	or	Ctrl	+	NStep	2.	Select	Custom	Configuration
WizardSelect	Custom	Wizard	and	click	NextStep	3.	Choose	VM	Hardware	Compatibility1.	Choose	the	compatible	hardware	from	the	drop-down2.	Click	NextStep	4.	Select	to	install	operating	system	later	option1.	Select	to	install	operating	system	later	option2.	Click	NextStep	5.	Select	the	guest	operating	system1.	Select	Windows	10	since	we	don’t
have	the	windows	server	option	included	yet.2.	Click	NextStep	6.	Virtual	Machine	Name	&	Location1.	Give	the	Virtual	Machine	Name	&	Location2.	Click	NextStep	7.	Select	Firmware	Type1.	You	can	select	either	BIOS	or	UEFI.	Note:	Only	new	boards	supports	UEFI.2.	Click	NextStep	8.	Allocate	the	number	of	processors	you	need1.	Allocate	how	many
processors	you	need.	This	depends	on	your	host	machine’s	hardware.2.	Click	NextStep	9.	Set	the	Memory	for	the	virtual	machine1.	This	depends	on	your	host	machine’s	hardware.	You	should	leave	the	memory	to	run	the	host	machine	without	hazels.2.	Click	NextStep	10.	Select	Network	Connection	settings	for	the	VM1.	Four	options	are	available	to
select.	Please	read	and	select	your	desired	network	setting.2.	Click	NextStep	11.	Choose	the	appropriate	storage	IO	controller1.	Choose	the	appropriate	storage	IO	controller2.	Click	NextStep	12.	Select	the	disk	type	for	the	VM1.	Select	the	available	disk	type	on	your	host	machine.2.	Click	NextStep	13.	Select	the	virtual	disk	for	the	VM1.	Select	the
virtual	disk	for	the	VM	if	not	create	a	new	disk2.	Click	NextStep	14.	Assign	the	disk	size	for	the	VMYou	can	select	a	single	or	split	virtual	disk	option.	Selecting	a	single	disk	will	increase	the	performance.	But,	if	you	want	to	move	the	disk	to	a	different	location	you	can	select	the	split	virtual	disk.Allocate	the	disk	size	and	click	next.Step	15.	Give	the
path	where	you	want	to	keep	the	VM	disk1.	Give	the	location	where	you	want	to	save	the	disk.2.	Click	Next.Step	16.	Create	the	VM1.	VM	settings	are	ready	to	create	the	VM.2.	Click	FinishStep	17.	Load	the	ISO	image	to	boot	the	VM1.	Select	use	ISO	image	file2.	Browse	the	ISO	image3.	Click	OkStep	18.	All	set	to	power	on	the	VMStep	19.	First	boot
screen	of	Windows	Server	2016Step	20.	Windows	Server	2016	installation	wizardThe	installation	wizard	will	appear	in	a	couple	of	seconds	after	the	boot1.	Select	the	language	time	and	keyboard	settings2.	Click	NextStep	21.	Install	Windows	Server	2016Click	on	Install	NowStep	22.	Select	The	Operating	System	You	Want	To	Install1.	Select	the
version	you	want	to	install2.	Click	NextStep	23.	Accept	the	License	AgreementStep	24.	Select	installation	methodSelect	custom	installation	if	you	are	doing	a	fresh	installation.	Or,	select	upgrade	if	you	are	upgrading	your	older	Windows	Server	to	Windows	Server	2016.Step	25.	Select	the	installation	disk	for	installationSelect	the	disk	and	click	on
Next	to	install	Windows	Server	2016.	If	you	want	to	create	additional	logical	partitions,	then	select	the	disk	and	click	on	new	assign	the	partition	size.	You	can	create	multiple	partitions	within	available	storage.Step	26.	Installing	Windows	Server	2016Step	27.	Installation	is	in	progress…Step	28.	Windows	getting	ready	after	the	installation
completesStep	29.	Create	Administrator	UserStep	30.	Windows	Server	is	ready	to	useStep	31.	Windows	Server	2016	Login	screenStep	32.	First	look	at	Windows	Server	2016This	is	how	you	should	Install	Windows	Server	2016	on	VMWare	Workstation.Thanks	for	reading	the	post.	Please	share	this	post	with	those	who	want	to	know	the	procedure	to
Install	Windows	Server	2016	on	VMWare.You	may	also	like	these	articles:	I've	downloaded	ISO	file	from	Microsoft	and	while	trying	Installer	disc	image	file	option	at	the	end	it	shows	an	error	"Windows	cannot	find	the	Microsoft	Software	License	Terms".	How	can	I	fix	this	error?	Thanks	5


